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Overview
This manual contains installation instructions, a description of the internal components and
operating procedures for the Universal Reflectance Accessory (URA). More detailed
information regarding the spectrometer and software can be found in the High-Performance
Lambda Spectrometer Getting Started Guide and the UV WinLab on-screen Help respectively.

Conventions Used in this Manual
Normal text is used to provide information and instructions.
Bold text refers to text that is displayed on the screen.
UPPERCASE text, for example ENTER or ALT, refers to keys on the PC keyboard. '+' is used
to show that you have to press two keys at the same time, for example, ALT+F.
All eight-digit numbers are PerkinElmer part numbers unless stated otherwise.

Notes, Cautions and Warnings
Three terms, in the following standard formats, are also used to highlight special
circumstances and warnings.
NOTE: A note indicates additional, significant information that is provided with some
procedures.
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CAUTION

We use the term CAUTION to inform you about situations that could
result in serious damage to the instrument or other equipment. Details
about these circumstances are in a box like this one.
Caution (Achtung)
Bedeutet, daß die genannte Anleitung genau befolgt werden muß, um
einen Geräteschaden zu vermeiden.
Caution (Bemærk)
Dette betyder, at den nævnte vejledning skal overholdes nøje for at
undgå en beskadigelse af apparatet.
Caution (Advertencia)
Utilizamos el término CAUTION (ADVERTENCIA) para advertir
sobre situaciones que pueden provocar averías graves en este equipo o
en otros. En recuadros éste se proporciona información sobre este tipo
de circunstancias.
Caution (Attention)
Nous utilisons le terme CAUTION (ATTENTION) pour signaler les
situations susceptibles de provoquer de graves détériorations de
l'instrument ou d'autre matériel. Les détails sur ces circonstances
figurent dans un encadré semblable à celui-ci.
Caution (Attenzione)
Con il termine CAUTION (ATTENZIONE) vengono segnalate
situazioni che potrebbero arrecare gravi danni allo strumento o ad
altra apparecchiatura. Troverete informazioni su tali circostanze in un
riquadro come questo.
Caution (Opgelet)
Betekent dat de genoemde handleiding nauwkeurig moet worden
opgevolgd, om beschadiging van het instrument te voorkomen.
Caution (Atenção)
Significa que a instrução referida tem de ser respeitada para evitar a
danificação do aparelho.
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We use the term WARNING to inform you about situations that could
result in personal injury to yourself or other persons. Details about
these circumstances are in a box like this one.
WARNING

Warning (Warnung)
Bedeutet, daß es bei Nichtbeachten der genannten Anweisung zu
einer Verletzung des Benutzers kommen kann.
Warning (Advarsel)
Betyder, at brugeren kan blive kvæstet, hvis anvisningen ikke
overholdes.
Warning (Peligro)
Utilizamos el término WARNING (PELIGRO) para informarle sobre
situaciones que pueden provocar daños personales a usted o a otras
personas. En los recuadros como éste se proporciona información
sobre este tipo de circunstancias.
Warning (Danger)
Nous utilisons la formule WARNING (DANGER) pour avertir des
situations pouvant occasionner des dommages corporels à
l'utilisateur ou à d'autres personnes. Les détails sur ces
circonstances sont données dans un encadré semblable à celui-ci.
Warning (Pericolo)
Con il termine WARNING (PERICOLO) vengono segnalate
situazioni che potrebbero provocare incidenti alle persone.
Troverete informazioni su tali circostanze in un riquadro come
questo.
Warning (Waarschuwing)
Betekent dat, wanneer de genoemde aanwijzing niet in acht wordt
genomen, dit kan leiden tot verwondingen van de gebruiker.
Warning (Aviso)
Significa que a não observância da instrução referida poderá causar
um ferimento ao usuário.
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Introduction
The Universal Reflectance Accessory (URA) is a variable angle specular reflectance measuring
module that loads directly into the detector compartment of the High-performance Lambda
spectrometers (and can be used in the Lambda 800/900). The detector compartment is fully
interchangeable with other sampling modules and can be quickly replaced by a different
module such as an integrating sphere, if required. The URA can be used to collect absolute
or relative reflectance measurements with an angle of incidence in the range 8°–65° and
utilizing wavelengths in the range 3100–190 nm (3100–185 nm with N2 purge). Samples are
placed on the horizontal sample plate and can range in size from 8 mm to greater than
150 mm. Samples with sizes between 3 mm and 8 mm could be measured using a
custom-made sample holder (not supplied by PerkinElmer). It is also possible to collect
transmittance and absorbance measurements when the URA is installed. Samples should be
placed in the sample compartment to collect these measurements.
Once fitted into the spectrometer, the URA can be fully controlled using the UV WinLab
software. This allows reproducible measurement at multiple angles and eliminates the need
to make manual adjustment to the optics or the sample.

Figure 1 The Universal Reflectance Accessory installed in a Lambda 650
spectrometer
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Unpacking and Inspection
Carefully check the accessory after unpacking for any damage that may have occurred during
shipping. If there is any such damage, file a claim immediately with the freight carrier and
contact your local PerkinElmer Service Engineer.

Do not power up the URA without first removing the transit clamp or
you may do serious damage to the accessory. See Moving the Universal
Reflectance Accessory on page 27 for more details.
WARNING
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Common Beam Depolarizer and Double
Polarizer Drive Accessories
Due to polarization of light within the spectrometer, it is necessary to use either a Common
Beam Depolarizer (CBD) or a Double Polarizer Drive when collecting reflectance
measurements at angles greater than approximately 12° from normal.
The CBD is acceptable for most analyses. It needs to be installed in the spectrometer by your
PerkinElmer Service Engineer.
However, for reflectance measurements at small spot sizes or higher angles (>45°) use the
Double Polarizer Drive. You can easily fit this yourself into the sample compartment of the
spectrometer.
Accessory

Part Number

Common Beam Depolarizer

B0501282

Wavelength range 190–900 nm (Lambda 650, 800, 850), 190–2600 nm
(Lambda 900, 950, 1050).
Double Polarizer Drive

B0505530

Requires one or two of the following parts
B0505284, N1010520, B2205021, B2205022.
Polarizer Crystal for Double Polarizer Drive

B0505284

Wavelength range 300–900 nm (Lambda 650, 800, 850), 300–2600 nm
(Lambda 900, 950, 1050). Thickness 30 mm.
Polarizer Crystal for Double Polarizer Drive

N1010520

Mounted 15 mm Glan–Taylor polarizer.
Wavelength range 210–1000 nm. Thickness 15 mm.
Depolarizer Crystal for Double Polarizer Drive

B2205021

Wavelength range 190–900 nm (Lambda 650, 800, 850), 190 – 2600 nm
(Lambda 900, 950, 1050). Thickness 30 mm.
Film Polarizer for Double Polarizer Drive
Wavelength range 400–700 nm. Thickness 2 mm.

B2205022
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Warnings and Safety Information
If the equipment is used in a manner not specified herein, the
protection provided by the equipment may be impaired.
WARNING
A warning sign is displayed on top of the accessory to the front of the sample plate.

Warning sign
displayed on sample
plate.

Figure 2 Position of the warning label on the URA

Do not stare into the beam!

WARNING
The Universal Reflectance Accessory module weighs 13 kg.
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Hardware Installation
The Universal Reflectance Accessory replaces the detector compartment and detector
circuitry installed in the spectrophotometer – the accessory has its own detectors and
pre-amplifier board. If the detector board connectors between the accessory and
spectrophotometer do not connect properly, damage to the pins may result during
subsequent accessory removal and installation. Once the accessory has been installed and
the optics have been aligned, the unit can be loaded safely into the instrument and removed
as necessary to facilitate normal spectrophotometer operations.

Before installing the URA in the instrument, you must ensure that the
instrument power supply is switched off and the line power cord is
disconneced.
WARNING
To install the URA:
1. Switch OFF the spectrometer and then disconnect the line power cord.
2. Open the sample compartment cover.
3. Remove the two caps on the top of the detector to expose the retaining screws.
4. Undo the retaining screws using the long posidrive screwdriver supplied with the
spectrometer.
5. Remove the detector compartment by carefully lifting vertically away from the
spectrometer using the two handles.
6. Lift and place the URA into the detector compartment of the spectrometer.
The URA is enclosed in a rugged plastic housing mounted securely to a solid aluminum
base plate. During handling, the operator should grasp the handle molded into the top
panel with the left hand and the handle in the right panel using the right hand as shown
in Figure 3. When the locating pins on the spectrometer connect with the holes on the
base of the URA, gently lower the accessory into the vacated detector chamber.
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Cap covering
retaining screw
access hole

Left handle

Right handle

Figure 3 How to hold the accessory
7. Remove the two caps on the top of the URA to expose the retaining screws.
8. Tighten the retaining screws using the long posidrive screwdriver supplied with the
spectrometer and then replace the caps.

Do not power up the URA without first removing the transit clamp or
you may do serious damage to the accessory. See Moving the Universal
Reflectance Accessory on page 27 for more details.
WARNING

Before removing the URA from the instrument, you must ensure that the
instrument power supply is switched off and the line power cord is
disconneced.
WARNING
To remove the URA:
1. Switch OFF the spectrometer and then disconnect the line power cord.
2. Open the sample compartment cover.
3. Remove the two caps on the top of the URA to expose the retaining screws.
4. Loosen the retaining screws using the long posidrive screwdriver supplied with the
spectrometer.
5. Carefully lift the URA vertically away from the spectrometer using the two handles.
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Software Installation


If you are installing the URA as part of the UV WinLab software installation, you will be
prompted to insert the Accessory CD.
Follow the instructions on the screen.

NOTE: This CD is only compatible with UV WinLab version 6.

NOTE: You must be logged on to Windows at Administrator level before installing the
software.
If you have already installed UV WinLab:
1.

Insert the Accessory CD (L6100130) into your CD drive.

2. If the installation program does not start automatically, select Run from the Start menu.
The Run dialog is displayed.

3. Enter d:\Setup.exe where d: is the CD drive and then click OK.
4. Follow the on-screen instructions.
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Description of Accessory Components
The Universal Reflectance Accessory is designed specifically to measure the reflectance of
samples that are placed on the sample plate on the top of the accessory. The main
components of the accessory include the optics, the detectors and the sample plate. A silicon
(Si) detector is used to make measurements in the UV/Vis wavelength range. A lead sulfide
(PbS) detector is used to make measurements in the near infra-red (NIR) range.
The URA can be used to collect absolute or relative reflectance measurements with an angle
of incidence in the range 8°–65°. When collecting absolute reflectance measurements, the
optics move automatically under software control to collect the baseline and sample
measurements. The light paths for the baseline and sample measurements are identical,
except for a single extra reflection off the sample in the sample measurement. The ratio of
the baseline and sample measurements gives the reflectance of the sample. When collecting
relative reflectance measurements, you are prompted to place the reference material on the
sample plate to acquire the baseline. In this case, the light beam is reflected towards the
sample plate for the baseline as well as the sample measurement.
You can easily change the size of the light beam directed at the sample. You should always
use the largest spot size possible. The default spot size of 5 mm × 5 mm is suitable for most
measurements at angles less than 60°. However, we recommend that at angles greater than
60°, you should use a maximum size of 4 mm × 4 mm. For smaller samples you may have to
reduce the spot size accordingly.
The following sections describe the position of the optics at the limits of operation for the
accessory. The URA operates at step intervals of 0.5° between 8° and 65°.
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When the Input Beam Angle of Incidence is 65°
The schematic in Figure 4 depicts the optics in the URA positioned to collect a baseline
measurement when the angle of incidence is 65°. The light path is displayed using a solid
line. The available movements of the pathlength compensator mirror, input mirror and
detector assembly are displayed using dashed arrows.
Pathlength compensator
mirror (motorized)

Sample
Input mirror
(angle set)

Detector
assembly

Fixed
mirror

In
Fixed mirror
Arc motion
Lift motion

Figure 4 URA baseline measurement when the angle of incidence is 65°
To collect sample measurements when the angle of incidence is 65°, the input mirror rotates
to direct the light off the sample. The detector assembly rises to capture the light after it has
reflected. This movement maintains the optical pathlength by compensating for the single
extra reflection in the sample measurement than in the baseline measurement. This is shown
in Figure 5.
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Pathlength compensator
mirror (motorized)

Sample
Detector
assembly
Input mirror
(angle set)

Fixed
mirror

In

Fixed mirror

Arc motion
Lift motion

Figure 5 URA sample measurement when the angle of incidence is 65°
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When the Input Beam Angle of Incidence is 8°
The schematic in Figure 6 depicts the optics in the URA positioned to collect a baseline
measurement when the angle of incidence is 8°. The light path is displayed using a solid line.
The available movements of the pathlength compensator mirror, input mirror and detector
assembly are displayed using dashed arrows.
Pathlength compensator
mirror (motorized)

Sample

Input mirror
(angle set)

Fixed
mirror
Detector
assembly
In

Fixed mirror

Arc motion

Lift motion

Figure 6 URA baseline measurement when the angle of incidence is 8°
To collect sample measurements when the angle of incidence is 8°, the input mirror moves to
a position below the sample plate so that it can direct the light off the sample at the correct
angle. The mirrors labelled ‘Pathlength compensator’ move to maintain the focus of the light
beam at the sample plate. The detector assembly also moves underneath the sample so that
it can capture the reflected light. This is shown in Figure 7.
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Pathlength
compensator mirror

Sample

Input mirror
(angle set)

Detector
assembly
Fixed mirror

Fixed mirror

In

Arc motion
Lift motion

Figure 7 URA sample measurement when the angle of incidence is 8°

Universal Reflectance Accessory User's Guide . 19

Operating Procedures
The URA is controlled using the UV WinLab software. This allows reproducible measurement
at multiple angles and eliminates the need to make manual adjustment to the optics or to
the sample.
In the UV WinLab software, a ‘Method’ acts as a template that holds all of the settings. The
first time that you use the URA, you will need to create a method. The following section
describes how to create and save a simple method that will be used to collect data for one
sample at two angles.
NOTE: The method can be reused any number of times. It is also possible to edit and
resave this method to collect larger data sets. When the method has been run, the
collected data is saved in a task. For more information see the UV WinLab on-screen
Help.

Creating a Method to Collect Reflectance
Measurements
To create a method, use the New Method Wizard:
1. Open UV WinLab.
The UV WinLab Explorer is displayed.
2. From the File menu select New, and then from the sub-menu select Method.
The New Method Wizard is displayed.
3. Select High performance UV/Vis/NIR instrument from the type of instrument dropdown list and then click Next.
The description field below lists all of the high-performance instruments.
The Choose the Instrument page of the Wizard is then displayed.
4. Select the type of spectrometer that you are using from the drop-down list, and then
click Next.
This associates your instrument with the method.
NOTE: Only instruments that have previously been installed are listed.

NOTE: You must add the current instrument to the list if it is not displayed. For a description
of how to add an instrument to this list, see the UV WinLab Help.
5. Select a method from the drop-down list.
The available method types are Scan, Wavelength Program, Timedrive, Wavelength
Quant, Scanning Quant and Polarization Scan.
6. Click Next.
The Select Accessories page is displayed.
7. Select the Universal Reflectance Accessory check box from the list of accessories.
This associates the URA with this method.
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8. Click Next.
The Finish page of the wizard is displayed. Edit upon completion is selected by
default. This means that the method opens in the workspace once it has been saved.
9. If you wish UV WinLab to install a shortcut to this method on your Desktop, select the
option.
10. Click Save/Finish.
The Save Method dialog is displayed.
11. Select the location for the new method.
12. The method has a default name. Click OK to save the method with the default name, or
enter a new name and then click OK.
If you are using the Enhanced Security (ES) version of UV WinLab, a security dialog will
be displayed prompting you for your User name, Password, Reason and Comment.
Enter the required details and then click OK.
The wizard closes and the method is created. If you selected Edit upon completion,
the method will open within the Workspace.
You now have to extend your method to include the specific settings that are necessary to
collect reflectance measurements. The software automatically recognises that the URA is
installed and generates the appropriate pages to control the accessory from within the
Workspace.
13. Select Data Collection from the Folder List.
The Data Collection page is displayed.
14. In the Method Settings section, ensure that the reflectance (%R) ordinate mode is
selected.
When the URA is installed, %R is the default setting for the ordinate mode.
15. Enter the required Method Settings.
The available scan range will depend on which type of URA you have installed on the
spectrometer. For a UV/Vis accessory, the range is 190–900 nm. For a UV/Vis/NIR
accessory, the range is 190–3100 nm.
The data interval corresponds to the step size between the collected data points. Ensure
that the data interval is set to an appropriate value for the scan range you require. If
the data interval is very small for a large scan range, the scan will take a long time.
NOTE: When scanning in the NIR region, the band in the wavelength range 2650–2820 nm
is due to absorption of water.
16. If using a Common Beam Depolarizer, ensure that the CBD check box is selected.
17. If using a double polarizer drive, select Sample Table from the upper drop-down list in
the Pol/Depol section.
This allows you to set the Polarization Angle for each sample in the Sample Table.
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18. Select the thickness of the polarization element from the Type drop-down list in the
Pol/Depol section.
The thicknesses of the polarization elements are listed in Common Beam Depolarizer
and Double Polarizer Drive Accessories on page 9. The available options are None,
2 mm, 5 mm, 10 mm, 15 mm, 20 mm, 25 mm and 30 mm. This applies the necessary
correction to the focus.
19. In the Detector Settings section, ensure that the response time for the UV/Vis (Si)
detector and NIR detector (PbS, if available) is 1.0 second.
20. Select Universal Reflectance Accessory from the Folder List.
The Universal Reflectance Accessory page is displayed.

Figure 8 Universal Reflectance Accessory page
21. In the Description box, enter any text and information as appropriate to describe the
current method.
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22. In the Data collection section, select the appropriate option button representing the
required mode.
The available options are Absolute Reflectance Mode, Relative Reflectance Mode
and Transmission (Sample Compartment) Mode. When the reflectance (%R)
ordinate mode is selected on the Data Collection page, the Transmission (Sample
Compartment) Mode is not available.
When collecting absolute reflectance measurements, the optics move under software
control to collect the baseline and sample measurements. The baseline is collected from
the baseline position while the sample spectra are collected from the sample position.
When collecting relative measurements, you will be prompted to place the reference
material on the sample plate to acquire the baseline. The light beam is reflected
towards the sample plate for the baseline as well as the sample measurement.
23. In the Spot size section, select Physical setting to set the size of the light beam.
Selecting the Physical setting option button enables the Width and Length fields
below. Use these fields to define the required size in mm. The default spot size of 5 mm
× 5 mm is appropriate for most measurements at angles less than 60°. At angles
greater than 60°, we recommend a maximum spot size of 4 mm × 4 mm. Use the
largest spot size possible. However, for smaller samples you may have to reduce the
spot size accordingly. When you edit the physical settings, the Slit width and CBM (%)
instrument settings update automatically.
The values that are displayed in this section will be the default values for all samples in
the sample table. If you want to use a different spot size for different samples, edit the
Width and Length columns in the sample table, as required.
24. Select Corrections from the Folder List.
On the Corrections page, it is recommended that you use As required before next
measurement. This means that the baseline corrections for the sample are collected
prior to collecting the sample measurement. For example, if the sample is to be
measured at more than one angle, a baseline correction is stored for each angle. Use
the drop-down lists to define when the baseline corrections expire. For more
information about baseline corrections, see the UV WinLab on-screen Help.
NOTE: Ensure that the stray light cover is in position on the URA when baselines are
collected.
25. Select Sample Info from the Folder List.
The Sample Info page is displayed.
By default the Sample Table contains one sample.To increase the number of samples,
enter the required number in the Samples field located at the top left corner of the
page.
26. Click Format Sample Table.
The Table Builder dialog is displayed.
In this case you have one sample, but want to collect data at more than one angle.
Instead of entering a large number of samples into the Sample Table, you can collect
Measurements on the same sample. This means that data collection is quicker because
the software will measure all specified angles for the current sample before prompting
for the next sample.
27. Select the Design tab and then select Measurements from the drop-down list.
Enter 2 for the number of measurements. You can add up to a maximum of 200
measurements for each sample.
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28. Select whether to Sequence by sample or Sequence by measurement and then click
OK.
The recommended option is Sequence by sample which runs the samples in sample
order rather than measurement order. For example, if you had 2 samples (S1 and S2)
and each sample had 2 measurements (M1 and M2) – that is, S1M1, S1M2, S2M1, S2M2
– the samples would be run in the order: S1M1, S1M2, S2M1, S2M2.
Choose Sequence by measurement if you want to run the samples in measurement
order rather than sample order. For example, if you had 2 samples (S1 and S2) and
each sample had 2 measurements (M1 and M2) – that is, S1M1, S1M2, S2M1, S2M2 –
the samples would be run in the order: S1M1, S2M1, S1M2, S2M2.

Figure 9 Sample Table with URA installed
29. In this example, we will collect data at 8° and 45° for the single sample. Enter the
values 8.0° and 45.0° into the Angle column for Measurement 1 and Measurement 2 in
the Sample Table respectively.
The Width and Length columns display a spot size equal to 5 mm by 5 mm for both
measurements.
30. If using a Common Beam Depolarizer, select the required option from the drop-down
list in the CBDep column.
Typically, for samples to be measured using an 8° angle, select Off from the drop-down
list in the CBDep column. For samples to be measured using an angle greater than 8°
from normal, select On from the drop-down list in the CBDep column. However, note
that for some samples – for example, dielectric materials – you should use a Common
Beam Depolarizer at all angles.
31. If using a Double Polarizer Drive, make the required settings in the Polarizer Type and
Pol. Angle columns.
Select the thickness of the polarization element that is fitted in your Double Polarizer
Drive. The available options are None, 2 mm, 5 mm, 10 mm, 15 mm, 20 mm,
25 mm and 30 mm. This applies the necessary correction to the focus.
32. From the File menu, select Save Settings to Method to save the edited method.
33. Execute the method by clicking

on the toolbar.

When collecting absolute reflectance measurements, the software will prompt you to
place your sample on the sample plate on top of the URA. When collecting relative
reflectance measurements, the software will initially prompt you for your reference
material and then for your sample. Always replace the stray light cover.
NOTE: If samples fall through the sample hole into the accessory, you should contact your
PerkinElmer Service Engineer. The stray light cover should be placed over the sample
hole when the accessory is not in use.
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Collecting Transmittance or Absorbance
Measurements
When the Universal Reflectance Accessory is installed in the detector compartment of the
spectrometer, you can still use the sample compartment to collect transmittance or
absorbance measurements. However, the performance of the spectrometer is limited when
measurements are collected in this configuration.
NOTE: Ensure that the stray-light cover is in position on the URA when collecting
transmittance measurements, as the sample plate is not used during data acquisition.
To collect transmittance measurements:
1. In the UV WinLab software, create or open a method that has the URA selected.
For detailed information on how to create a new method, see steps 1–12 on page 19.
The Method opens in the Workspace.
2. Select Data Collection from the Folder List.
The Data Collection page is displayed.
3. In the Method Settings section, select transmittance (%T) or absorbance (A) Ordinate
Mode.
(When the Ordinate Mode is set to transmittance (%T) or absorbance (A), the
Transmission (Sample Compartment) Mode option on the URA Accessory page is
automatically selected and all of the other fields are unavailable.)
NOTE: When using the URA in transmittance or absorbance modes, always ensure that the
front beam is the sample beam in the Beam Selection section on the Data Collection
page.
4. If using a Common Beam Depolarizer, ensure that the CBD check box is selected.
5. If using a double polarizer drive, select Sample Table from the upper drop-down list in
the Pol/Depol section.
This allows you to set the Polarization Angle for each sample in the Sample Table.
6. Select the thickness of the polarization element from the Type drop-down list in the
Pol/Depol section.
The thicknesses of the polarization elements are listed in Common Beam Depolarizer
and Double Polarizer Drive Accessories on page 9. The available options are None,
2 mm, 5 mm, 10 mm, 15 mm, 20 mm, 25 mm and 30 mm. This applies the necessary
correction to the focus.
7. Enter the required wavelength values in the From and To fields.
The available range will depend on which type of URA you have installed on the
spectrometer. For a UV/Vis accessory, the range is 190–900 nm. For a UV/Vis/NIR
accessory, the range is 190–3100 nm.
8. Set the spacing between data points in the Data Interval field located below the scan
range fields.
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9. Select Corrections from the Folder List.
On the Corrections page, select the required options. For more information about
baseline corrections, see the UV WinLab on-screen Help. Ensure that the stray light
cover is in position on the URA when baselines are collected.
10. Select Sample Info from the Folder List.
The Sample Info page is displayed.
11. Enter the required number of samples in the Samples field.
For more information about formatting the Sample Table, see the UV WinLab on-screen
Help.
12. If using a double beam polarizer, make the required settings in the Polarizer Type and
Pol. Angle columns.
Select the thickness of the polarization element that is fitted in your double polarizer
drive. The available options are None, 2 mm, 5 mm, 10 mm, 15 mm, 20 mm,
25 mm and 30 mm. This applies the necessary correction to the focus.
13. Enter the thickness of the materials in the sample and reference beams into the
Sample Pathlength and Baseline Pathlength columns respectively.
This correction is only valid when the spectrometer is used in transmittance or
absorbance mode with the URA installed.
14. From the File menu select Save Settings to Method to save the edited method.
15. Execute the method by clicking

on the toolbar.
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Sample Preparation and Back-Surface
Reflection
The accuracy of reflectance results obtained using the URA will depend on the extent that
the light beam reflects off the back of the sample. This will depend on two factors:
•

Thickness of the sample;
Accuracy decreases as the sample thickness decreases.

•

Roughness of the back surface of the sample.
Accuracy increases as the roughness of the back surface of the sample increases.

Additionally, the amount of light entering the detector due to back-surface reflection
increases as the angle of incidence approaches normal.
To minimize these effects, where possible:
•

Use the thickest sample possible;
The light reflected off the back surface of the sample misses the detector.

•

Roughen the back surface of the sample using sandpaper.
This increases the diffuse reflection and light is scattered rather than reflected into the
detector.
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Moving the Universal Reflectance Accessory
If you need to move the URA any great distance, especially if the accessory will be subject to
vibrations or jolts, you should follow the guidelines below prior to removing the URA from the
spectrometer. These precautions are not necessary when simply removing the URA to
exchange the sampling module.
Before moving the URA:
1. In the UV WinLab software, create or open a method that will use the URA.
The Method opens in the Workspace.
2. Select Universal Reflectance Accessory from the Folder List.
The Universal Reflectance Accessory page is displayed.
3. In the Action section, click Transit Position to lock the internal components of the
accessory into position.
4. Exit the UV WinLab software.
5. Switch off the spectrometer.
6. Remove the URA from the spectrometer.
For more information see Hardware Installation on page 11.
7. Carefully turn over the URA and lower the top surface on to the benchtop.
8. Loosen the screws of the transit clamp on the base of the unit, slide it to the ‘Engaged’
position as shown in Figure 10 and then retighten the screws.
It is now safe to move the URA.

Figure 10 Transit clamp in locked (engaged) position, and transit clamp warning
label

Moving the URA without locking the internal components into transit
positions may result in serious damage to the accessory. Always follow
the precautions given above before shipping the unit.
WARNING
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When you reinstall the URA you must remove the transit clamp before use.


To remove the transit clamp, loosen the screws of the clamp on the base of the unit,
slide it to the ‘Disengaged’ position as shown in Figure 11 and then retighten the
screws.

Figure 11 Transit clamp in released (disengaged) position, and transit clamp
warning label

Do not power up the URA without first removing the transit clamp or
you may do serious damage to the accessory.
WARNING
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Troubleshooting and Maintenance
Check the following troubleshooting table to see if the problem can be easily corrected.
Problem

Probable Cause

Remedy

Spectra are noisy.

External light may be
entering via the sample
plate.

Make sure that the stray light
cover is in position when
collecting measurements.

Spot size is too small.

Increase the spot size.

Laboratory temperature is
too high.

Reduce laboratory
temperature. If the problem
persists contact your
PerkinElmer Service
Engineer.

NIR detector temperature
error.

If the source of the problem appears to be a malfunction of the accessory, it is strongly
recommended that you contact your PerkinElmer Service Engineer.

Hazardous voltages are present in the URA

WARNING

Do not operate the accessory with the cover removed. Do not attempt to
make adjustments or repairs yourself. Only a PerkinElmer Service
Engineer should service the accessory.

NOTE: When the accessory is not in use, you should always replace the stray light cover to
exclude dust from the accessory optics.
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